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OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, 
DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF 
LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

The following disclaimer is required by the Independent JPEG Group:
This software is based in part on the work of the Independent JPEG Group.

This Software may contain components licensed under the following conditions:
Copyright (c) 1989 The Regents of the University of California. All rights reserved. 

Redistribution and use in source and binary forms are permitted provided that the above copyright notice and this paragraph 
are duplicated in all such forms and that any documentation, advertising materials, and other materials related to such 
distribution and use acknowledge that the software was developed by the University of California, Berkeley. The name of the 
University may not be used to endorse or promote products derived from this software without specific prior written 
permission. THIS SOFTWARE IS PROVIDED ``AS IS'' AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE. 

Copyright (C) 1989, 1991 by Jef Poskanzer. 

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby 
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© 2006 Nexidia.  All rights reserved.
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The following disclaimer is required by Ultimatte Corporation:
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The following disclaimer is required by Interplay Entertainment Corp.:
The “Interplay” name is used with the permission of Interplay Entertainment Corp., which bears no responsibility for Avid 
products.

This product includes portions of the Alloy Look & Feel software from Incors GmbH.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

© DevelopMentor

This product may include the JCifs library, for which the following notice applies:
JCifs © Copyright 2004, The JCIFS Project, is licensed under LGPL (http://jcifs.samba.org/). See the LGPL.txt file in the Third 
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Avid Interplay contains components licensed from LavanTech. These components may only be used as part of and in 
connection with Avid Interplay.

Attn. Government User(s). Restricted Rights Legend
U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or 
“commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf 
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Xmon, XPAND!, Xponent, X-Session, and X-Session Pro are either registered trademarks or trademarks of Avid Technology, 
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Adobe and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States 
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countries. Windows is either a registered trademark or trademark of Microsoft Corporation in the United States and/or other 
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Footage
Arri — Courtesy of Arri/Fauer — John Fauer, Inc.
Bell South “Anticipation” — Courtesy of Two Headed Monster — Tucker/Wayne Atlanta/GMS.
Canyonlands — Courtesy of the National Park Service/Department of the Interior.
Eco Challenge British Columbia — Courtesy of Eco Challenge Lifestyles, Inc., All Rights Reserved. 
Eco Challenge Morocco — Courtesy of Discovery Communications, Inc.
It’s Shuttletime — Courtesy of BCP & Canadian Airlines. 
Nestlé Coffee Crisp — Courtesy of MacLaren McCann Canada. 
Saturn “Calvin Egg” — Courtesy of Cossette Communications. 
“Tigers: Tracking a Legend” — Courtesy of www.wildlifeworlds.com, Carol Amore, Executive Producer.
"The Big Swell" — Courtesy of Swell Pictures, Inc.
Windhorse — Courtesy of Paul Wagner Productions.

Arizona Images — KNTV Production — Courtesy of Granite Broadcasting, Inc., 
Editor/Producer Bryan Foote.
Canyonlands — Courtesy of the National Park Service/Department of the Interior.
Ice Island — Courtesy of Kurtis Productions, Ltd.
Tornados + Belle Isle footage — Courtesy of KWTV News 9.
WCAU Fire Story — Courtesy of NBC-10, Philadelphia, PA.
Women in Sports – Paragliding — Courtesy of Legendary Entertainment, Inc.

Avid Editors on Interplay Workflow Guide • June 2010

http://www.wildlifeworlds.com


  

6



7

Contents

Chapter 1 Avid Interplay Production . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9

Interplay Components . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  11

Chapter 2 Working on Projects in an Avid Interplay Environment . . . . . . . . . . . . .  15

Checklist: Preparing Interplay to Share and Edit Projects  . . . . . . . . . . . . . . . . . . . .  15

Setting up a Workgroup with Shared Projects and Storage . . . . . . . . . . . . . . . . . . .  16

Configuring Media Indexer to Monitor Shared Storage. . . . . . . . . . . . . . . . . . . . . . .  18

Configuring the Local Media Indexer to Recognize Shared Storage  . . . . . . . . . . . .  22

Configuring the Local Media Indexer to Index Local Drives . . . . . . . . . . . . . . . . . . .  27

Checklist: Editing Projects in an Interplay Environment . . . . . . . . . . . . . . . . . . . . . .  32

Configuring Interplay Settings on the Editing Workstation  . . . . . . . . . . . . . . . . . . . .  34

Working with Interplay and Remote Assets  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  36

Creating Avid Editing Projects in an Interplay Environment . . . . . . . . . . . . . . . . . . .  38

Logging in to Interplay and Opening the Interplay Window. . . . . . . . . . . . . . . . . . . .  44

Connecting to the Media Services Engine from an Avid Editing Application  . . . . . .  45

Checking Avid Assets Out Using the Interplay Window . . . . . . . . . . . . . . . . . . . . . .  46

Checking Avid Assets Out Using Interplay Access . . . . . . . . . . . . . . . . . . . . . . . . . .  48

Checking Avid Assets In to the Interplay Database  . . . . . . . . . . . . . . . . . . . . . . . . .  48

Understanding Reservations. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  51

Chapter 3 MultiRez Workflow in an Interplay Environment . . . . . . . . . . . . . . . . . . .  53

Preparing Interplay for MultiRez . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  54

Acquiring Media at Multiple Resolutions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  57

Archiving the High-Res Media. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  64

Editing with MultiRez Media  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  69

Chapter 4 Conforming Projects on Avid DS in an Interplay Environment . . . . . . .  85

Checklist: Conforming Projects on Avid DS in an Interplay Environment . . . . . . . . .  85

Workgroup with Shared Storage in an Avid Interplay Environment  . . . . . . . . . . . . .  88

Configuring the Interplay Adapter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  90

Sharing Media . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  91

Defining your Storage Areas within the Media Indexing Service  . . . . . . . . . . . . . . .  96



8

Accessing Storage on Workstations in an Avid Interplay Environment . . . . . . . . .  102

Exporting the Finished Sequence to Avid DS via Interplay  . . . . . . . . . . . . . . . . . .  104

Importing and Opening the Sequence in Avid DS . . . . . . . . . . . . . . . . . . . . . . . . .  104



1 Avid Interplay Production

Avid Interplay is a production asset management system that allows editors, producers, 
reporters, and audio/video technicians access to all the current working media and project 
information through a central database. This allows for simultaneous use of media, and eases 
the multi-editor collaboration.

Avid Interplay provides a central database of assets (such as master clips, subclips, 
sequences, graphics, bins and sequences) that you use during your production process. 
Interplay keeps account of all versions of the assets from creation to archive. For example, 
you can capture your media at multiple resolutions onto the shared storage, link to the lower 
resolution when editing, and then automatically relink to the higher resolution media for 
finishing and output.

Interplay facilitates the collaborative editing process by allowing the various stations in the 
workgroup to:

• access multiple resolutions and versions of media and other assets from the shared 
storage without contention

• transfer sequences from one Avid editing application to another for audio mixing or 
special effects and finishing.

This book shows you how to set up and use an Avid editing system in an Avid Interplay 
workgroup with Unity shared storage. Avid editing systems include Avid Media Composer, 
Avid Symphony, Avid DS, and Avid Pro Tools.

The illustration below shows how projects and media can be managed and shared in an 
Interplay environment.
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1. Capture/Transcode/Archive Media on Shared Storage

Use Avid AirSpeed Multi Stream to ingest media files at both high- and low-resolution to an 
Avid Unity storage for access by the editing systems. If additional lower resolutions are 
needed, then Interplay can transcode these on an as-needed basis.

Any media that is currently not in use can be archived and stored offline until required. The 
Interplay Engine easily manages sequences and other media objects whose media is no 
longer online. You can search for these objects, view information about them such as the 
source tape name, obtain the source footage, and rerecord or recapture it.

Avid Media Composer

2

1

Avid DS 

Avid Interplay Admin
Avid Interplay Access

Avid Unity

4

Avid Interplay Server

Avid ProTools

Avid AirSpeed
Multi Stream

3
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2. Edit the Sequence

Using Interplay, many editors can work on projects using the same assets at the same time. 
With Interplay Access, you can search or browse folders that organize assets from across all 
workspaces. Interplay tracks the locations of assets, including all resolutions of a master 
clip, and allows you to easily pull them into your project. 

When the sequence is ready for the effects and finishing process, a Media Composer editor 
can check it in to the Interplay database as an AFE file. 

Similarly, for audio mixing and sound effects process, the Avid Media Composer or Avid DS 
editor can export the sequence and check in the AAF. 

3. Mixing the Audio and adding Sound Effects

The sound editor using Avid Pro Tools can then import the AAF and relink to the audio  files 
to finalize the sound editing. 

4. Conforming and Finishing the Sequence

The Avid DS editor checks-out the AFE, conforms and relinks to the high-resolution media. 
After adding the necessary visual effects and finishing touches, the sequence is rendered to 
the required delivery format and all the necessary project files and new media are checked 
back in to Interplay.

If the sequence needs to be sent back to Media Composer, it can be exported as an AAF file 
by using the “Timeline to MC” option, and then checking the AAF file into the Interplay 
database.

From this point, there are different options for final delivery:

• Send the final sequence to Avid Airspeed for broadcast or playback (available only from 
the Media Composer product family).

• Output the necessary format and record to tape, film, or DVD.

Interplay Components

An Interplay workgroup consist of clients and servers. Clients are editing wokstations such 
as Media Composer, Avid DS, and Avid Protools. Servers are responsible for managing the 
clients, running the Interplay Engine, and providing a number of services to aid the clients in 
an editing workflow.
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In a small workgroup, such as one with ten or fewer clients, all of the server components can 
be run on a single machine. In this case, it is possible that a client can also act as the 
Interplay server. In larger workgroups, the Interplay server components are spread among 
many dedicated server machines.

Listed below are the Interplay components configurable on the server and/or the clients. 
Some of the components listed are optional since they are not critical for Interplay to 
function, but may be required in some workflows.

Interplay Engine: Server Component

The Avid Interplay Engine forms the backbone of the Interplay environment. The Interplay 
Engine is a server that combines an asset database with workflow management software, 
both of which are integrated with Avid shared storage and Avid archive solutions.

Interplay Administrator: Server and Client Component

The Interplay Administrator is a cross-platform application used for basic administration of 
the Avid Interplay Engine and the Avid Interplay Archive Engine. Interplay Administrator is 
automatically installed with Interplay Access. You can perform administrative tasks from 
any machine connected to Interplay. Supported capabilities include the following:

• Database activation, creation, and security

• Scheduling backups

• Setup of users

Interplay Access: Server and Client Component

The Avid Interplay Access software is a dedicated application that can be used by system 
administrators and other designated users such as editors, assistants, and producers to 
interact with the Avid Interplay Engine. A lightweight version of Interplay Access, referred 
to as the Interplay window, is built into Interplay-enabled editing applications.

The Avid Interplay Access user interface allows you to quickly search or browse the 
Interplay database for assets of interest. Drag-and-drop support allows you to obtain Avid 
assets by dragging them to the Avid editing application’s Interplay Window.

Interplay Media Indexer: Server and Client Component

The Avid Interplay Media Indexer is a background service that keeps track of the media files 
in storage locations that you identify. In an Avid Interplay environment, each Avid editing 
application has its own local Media Indexer that manages the local storage areas on that 
system. Each Avid Interplay environment also has at least one Media Indexer that manages 
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media on shared storage. When the Avid editing application needs to access media on shared 
storage, it communicates with its local Media Indexer, which then communicates with the 
shared storage Media Indexer.

Interplay Transfer: Server Component (Optional)

Avid Interplay Transfer lets you transfer Avid assets to and from another workgroup, send 
finished sequences to a configured playback device, and capture media from a configured 
ingest device.

Interplay Low Res Encode: Server Component (Optional)

CaptureManager™ and Interplay Capture allow you to capture high-resolution and 
low-resolution material at the same time. CaptureManager and Interplay Capture use Avid 
AirSpeed® or AirSpeed Multi Stream to capture high-resolution material and uses Avid 
Interplay Low Res Encode software to capture low-resolution material. 

Interplay Media Services: Server Component (Optional)

Avid Interplay Media Services are specific tasks that can be distributed among dedicated 
workstations in a network environment. Offloading work to dedicated machines frees up 
computer resources to perform other tasks.

Media Services are registered with the Media Services Engine, which is responsible for 
matching tasks with the appropriate service provider. The following table lists the services 
managed by the Media Services Engine. 

n The services managed by the Media Services Engine are not limited to the services listed in 
this table. For more information about installing and configuring these servces, see the Avid 
Interplay Media Services Setup and User’s Guide.

Interplay Media Services Service Providers

Service Description

Avid Interplay Transcode service Lets you transcode Avid assets from one Avid-supported resolution 
to another. For example, you can use the Avid Interplay Transcode 
service to create a low-resolution version of a sequence or master 
clip.

Avid Interplay Archive service 
Avid Interplay Restore service

Provides access to archive and restore features. The Avid Interplay 
Archive and Restore services manage the process of moving data, 
instead of using the Avid Interplay Transfer Engine.
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Avid Interplay Stream Publish service Lets you create QuickTime reference movies that refer to MPEG-4 
video files and MPEG1 Level 2 audio files. The files are checked into 
the Interplay database so you can play the assets via Interplay 
Access.

Avid Interplay Copy service Lets you copy assets (metadata) and their media files from one 
workgroup to another.

Avid Interplay Move service Lets you move media files from one Avid Unity ISIS workspace to 
another.

Avid Interplay Delivery service Lets you transfer a clip and its media files or only the portion that is 
used in a subclip or a sequence.

Avid Interplay Auto Media Service

• Auto Archive

• Auto Transcode

• Auto Transfer

• Auto Copy

Lets you configure folders and subfolders to perform tasks 
automatically. You can use the Avid Service Configuration settings to 
configure the various auto media services.

n An auto archive and auto transcode operation includes 
subfolders. An auto transfer operation does not include 
subfolders. An auto copy operation maintains the same folder 
structure as the source workgroup.

Avid Interplay STP Encode service During a send-to-playback request from the Avid editing application 
or Avid Interplay Assist, lets you offload time-consuming processing 
involved in exporting and transferring of Long GOP OP1a media.

Avid Interplay ProEncode™ service Provides integration to AnyStream™ and Telestream for non-Avid 
format transcode services (for example, transcoding from an Avid 
resolution to Windows Media File format).

Interplay Media Services Service Providers (Continued)

Service Description
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Interplay Environment

Since there’s a large need to share projects and media for offline-to-online production 
between Avid systems, all the media, in both high-res and low-res, can be placed on the 
same Unity storage for access by different editing workstations at the different stages of the 
post-production process. Interplay extends the functionality of Avid Unity, providing an 
easier way for editors to track and share media.

A typical example would be a production using film footage that was scanned to DPX digital 
files. The DPX media would be placed on the shared storage where it could be transcoded by 
Avid MetaFuze to MXF media that a Media Composer system could link to for offlining. 
The offline sequence can then be exported as an AFE to an Avid DS for conform which 
easily links back to the original DPX files for the finishing process.

Checklist: Preparing Interplay to Share and Edit 
Projects

The administrator configuring the hardware and software components in the Interplay 
environment must follow these steps in the order listed to ensure that all components 
function successfully.

Preparing the Interplay environment: Refer to:

 Set up the environment so that Avid editing systems can 
access the shared storage.

“Setting up a Workgroup with 
Shared Projects and Storage” on 
page 16.

 Install and configure the necessary components on the 
Interplay server.

“Installing Software on the 
Interplay Servers” in the 
Interplay Help.

 Install necessary Interplay Media Services and register 
them with the Media Services Engine.

“Avid Interplay Media Services 
Setup and User’s Guide” in the 
Interplay Help.
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Setting up a Workgroup with Shared Projects and 
Storage

In cases where there is a large need to share projects and media between workstations, the 
media storage can be centralized on an Avid Unity storage. Set up your environment as 
illustrated in the following figure, so that Avid editing systems workstations can access 
media stored on an Avid Unity.

 Use Interplay Administrator to configure the Interplay 
environment and set-up user accounts.

“Avid Interplay Engine and Avid 
Interplay Archive Engine 
Administration Guide” in the 
Interplay Help.

 Configure the Avid Interplay Media Indexer to monitor 
shared storage.

“Configuring Media Indexer to 
Monitor Shared Storage” on 
page 18.

Preparing the Media Composer/Symphony clients:

 Install and configure the required software components on 
Media Composer and Symphony.

“Installing Software on Avid 
Editing Systems” in the Interplay 
Help.

 Configure the local Media Indexer on each editing 
workstation.

“Configuring the Local Media 
Indexer to Recognize Shared 
Storage” on page 22.

“Configuring the Local Media 
Indexer to Index Local Drives” 
on page 27.

 If you have not already done so, connect each workstation 
to the shared Avid Unity storage.

 “Mounting and Unmounting 
Workspaces” in the Avid Unity 
documentation.

 Configure your editing application to connect to an 
Interplay server and specify a location for your project’s 
Interplay folder.

“Configuring Interplay Settings 
on the Editing Workstation” on 
page 34.

 Configure your editing application and Interplay Access 
to connect to a Media Services Broker, enabling you to 
initiate media services inside.

“Connecting to the Media 
Services Engine from an Avid 
Editing Application” on page 45.
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The Avid Unity storage needs to have a workspace for each editing client. Within the 
workspace, set up separate folders for video and audio, and set the necessary permissions. 
Refer to the documentation that came with the Unity storage.

Avid Media Composer

3

2

Avid DS

1

Avid DS 

Avid DS
Controller

Avid Symphony

Avid Unity

4

Element

1 Avid Media Composer has its own workspace on the Unity.

2 Avid Symphony has its own workspace on the Unity.

3 Each Avid DS client has a workspace on the Unity. The Avid DS Controller indexes 
all DS project and media in an Avid DS workgroup.

4 If Media Composer/Symphony needs to share files with Avid DS, then additional 
workspaces are required for the shared media. The Avid DS Controller indexes these 
workspaces as well.
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Configuring Media Indexer to Monitor Shared 
Storage

The following procedure describes how to set up a Media Indexer to monitor shared storage. 
Typically, this type of Media Indexer is configured to run on an Interplay server.

To configure Media Indexer to monitor shared storage:

1. Identify the Media Indexer as the leader of a High Availability Group (HAG).

See “Grouping Media Indexer Services” in the Interplay Help.

2. Identify the shared storage locations for that Media Indexer to monitor.

3. Click the Start button, and then select All Programs > Avid > Avid Service Framework > 
Avid Service Configuration. 

4. On the Hosts tab in the Directory pane, select the system that contains the Media 
Indexer you want to use to monitor shared storage.

5. Select Avid Media Indexer. 

The system might prompt you for the Interplay Framework administrator password (by 
default, there is no password). 

n By default, Avid Service Framework does not require a password. When a password is used, 
it is set through the Avid Service Configuration application. Check with your system 
administrator for the correct password.

6. Click OK.

 A message box opens asking if you want to allow the service to run with unrestricted 
security

7. Click Yes.

The system displays the Media Indexer information in the Avid Service Configuration 
dialog box.



Configuring Media Indexer to Monitor Shared Storage

19

8. Click Join High Availability Group and type a unique name for the group. 

n Perform this step even if there is only one Media Indexer for shared storage. The Media 
Indexer that monitors shared storage must be part of a High Availability Group (HAG) even 
if there is only one Media Indexer in the group.

9. Click Apply.
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10. Click Configure in the Storage section of the Configuration pane.

The Configure Storage dialog box opens. The following illustration shows a Media 
Indexer that is already configured to monitor folders on two workspaces on an Avid 
Unity.
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11. Click Add to add a storage location (workspace).

The Add Storage dialog box opens.

12. Select the Media Files Location option and click OK.

The Media Files Location dialog box opens.

13. Type the Universal Naming Convention (UNC) path to a folder within the workspace. 
For example, \\workstation_name\workspace_name\folder_name.

The following illustration shows the UNC path for the Avid MediaFiles folder on 
workspace3. The storage system name in this example is avid-6c85183baf.

n In general, avoid connecting directly to the high level workspace name. Connect to the Avid 
MediaFiles folder or another folder in the workspace that you know contains valid Avid 
media files. This way you won’t waste time and system resources indexing non-Avid files.

14. Click Apply and click OK.

The system displays the Universal Naming Convention (UNC) path to the folder in the 
Configure Storages dialog box.
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The message “Normal” indicates that the drive has been scanned and will be indexed. 
The message “Normal - Scanning” indicates the Media Indexer is now scanning the 
storage area. 

n On shared storage, you must use Universal Naming Convention (UNC) path as the Media 
Indexer does not recognize mapped drive letters. 

15. (Option) Click Add and repeat the process to add any additional folders.

16. Click Apply, and then click OK to close the Configure Storages dialog box.

n The first time that you configure a storage folder, the Media Indexer automatically indexes 
the media in the folder. This might take a while depending on the amount of media in the 
folder.

Configuring the Local Media Indexer to Recognize 
Shared Storage

Each Avid editing application in an Avid Interplay environment has a local Media Indexer 
that indexes local storage. You typically chain this Media Indexer to the Media Indexer that 
indexes your shared storage.

Your editing system uses the Media Indexer chain as follows:

1. Your Avid editing application sends a request to the local Media Indexer for media.

2. The local Media Indexer checks its index to determine whether the media is available on 
the local drives.

3. If the media is not available on the local drives, the local Media Indexer forwards the 
request to the first Media Indexer in the chain. 
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The local Media Indexer uses the Avid Service Framework Lookup service to locate 
Media Indexer services in the chain.

4. If that Media Indexer doesn’t have a record of the media, the local Media Indexer 
forwards the request to the next Media Indexer in the chain.

An administrator can configure the Media Indexer services for the Avid editing applications 
on the individual system or from any system running the Avid Service Configuration 
application.

To configure the Media Indexer for an Avid editing application:

1. Click the Start button, and then select Programs > Avid > Avid Service Framework > 
Avid Service Configuration.

2. If more than one workgroup appears in the list, click the Expand List icon next to your 
Workgroup name to expand the Workgroup list.

3. Locate the Avid editing system in the list and select the Media Indexer service. 

The following illustration shows an Avid editing system named techpub8200n.

The system might prompt you for the Avid Service Framework administrator password 
(by default, there is no password).
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The system displays a message asking if you want to allow the service to run with 
unrestricted security.

4. Click Yes.

5. Click the Configure Storages button.

The Configure Storages dialog box opens.

6. Click Add.

The Add Storage dialog box opens.
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7. Select Avid Media Indexer and click OK.

The Avid Media Indexer dialog box opens

8. Select the Connect to a High Availability Media Indexer Group option.

9. Select an indexer group from the Group Name list.

n Ask the Avid Interplay system administrator for the name of the High Availability Group 
(HAG).

10. Select a mode for the connection as follows:

Mode Type When to Use this Mode

c All Avid editing systems that are part of a load-balanced group should have their chain 
configured as load balanced. Otherwise load balancing won’t occur and all Media 
Indexer services only communicate with the master.

Load Balancing Choose this option if you want the Media Indexer to select any Media 
Indexer in the group. If this Media Indexer goes offline, the system 
connects to another indexer in the group. 

Master Only Choose this option if you want to connect to the group leader. If the 
group leader goes offline, the Avid Service Framework selects a new 
leader and connects to it.
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11. Click Apply, and then click OK.

The system displays the high availability group in the Configure Storage dialog box.

You can have as many Media Indexer services as you want in the Configure Storage 
dialog box.

n Avid recommends that you do not nest Media Indexer services within the Configure Storage 
dialog box because it could overly complicate the management of your Media Indexer 
services.

12. Click Apply and then click OK to close the Configure Storage dialog box.

An administrator can select the Processes tab on the Interplay Service Configuration 
window and configure the Media Indexer services for all the systems on the Interplay 
environment from that tab. 

The following illustration shows the Processes tab with the Media Indexer for shared 
storage selected.
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Configuring the Local Media Indexer to Index 
Local Drives

Each Avid editing application in an Avid Interplay environment has a local Media Indexer 
that indexes local drives.

n For information on configuring Media Indexer to index a P2 card, see the Avid Interplay 
Software Installation and Configuration Guide.

To configure the local Media Indexer to index your local drives:

1. Click the Start button, and then select Programs > Avid > Avid Service Framework > 
Avid Service Configuration.

2. If more than one workgroup appears in the list, click the Expand List icon next to your 
Workgroup name to expand the Workgroup list.
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3. Locate the Avid editing system in the list and select the Avid Media Indexer service. 

The following illustration shows an Avid editing system named techpub8200n.

The system prompts you for the Avid Service Framework administrator password.

n By default, Avid Service Framework does not require a password. When a password is used, 
it is set through the Avid Service Configuration application. Check with your system 
administrator for the correct password.

The system displays a message asking if you want to allow the service to run with 
unrestricted security.

4. Click Yes.

5. Click Configure Storages.
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The Configure Storage dialog box opens. In the following illustration you can see that 
this local Media Indexer is already connected to the shared storage Media Indexer.

6. Select the Media Table icon and click Add.

The Add Storage dialog box opens.

7. Select Media Files Location and click OK.

The Media Files Location dialog box opens
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8. Click the Browse button.

The Open dialog box displays.

n Unlike the UNC pathname rule for shared storages you are allowed to use the drive letters 
for local storage.

9. Navigate to the location of your Avid MediaFiles folder. 

The following illustration shows the Avid MediaFiles folder on a MediaDock storage 
device.

10. Click Open.

The Media Files Location dialog box opens and displays the new location.

Browse button.
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11. Click Apply and then OK.

The Configure Storages dialog box opens and displays the new location.

12. (Option) Click Add to add any additional storages.

13. Click Apply and then OK to close the Configure Storage dialog box.

14. Close the Interplay Service Configuration window.

To instruct Media Indexer to automatically recognize local drives:

1. Start the Avid editing application.

2. Click Tools > Media Creation.

The Media Creation window opens.

Local 
storage
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3. On the Drive Filtering and Indexing tab, click the “Auto-index local drives as they come 
online” button.

The local Media Indexer automatically configures Avid media files on your local drives.

4. (Option) Click Manual Storage Scan to start a scan.

5. (Option) Select one of the warning options. The warning occurs if the Media Indexer 
has problems scanning files on the local drive.

n If you don’t want the Media Indexer to automatically scan your local drives, deselect the 
Auto-index  option.

Checklist: Editing Projects in an Interplay 
Environment

The checklist below provides a basic list of steps for sharing and editing projects and media 
between Avid editing systems in an Avid Interplay workgroup environment. For more details 
on working with Interplay, refer to the documentation that came with your Interplay or Avid 
editing system.

You should also consider using a multirez workflow to save storage space and time while 
editing—see “MultiRez Workflow in an Interplay Environment” on page 53.

Editing in the Interplay environment: Refer to:
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 Learn about working with your bins in Interplay. “Working with Interplay 
and Remote Assets” on 
page 36

 Create a project in the appropriate location, using the proper 
naming convention.

“Creating Avid Editing 
Projects in an Interplay 
Environment” on page 38.

 Log in to Interplay when prompted by the editing application. “Logging in to Interplay 
and Opening the Interplay 
Window” on page 44.

 Create a new bin, or use one that you are confident is not 
being used by any other users at the same time.

 Use the Interplay Window in your editing application or 
Interplay Access to check out and work with shared media. 
NEVER open bin files (*.avb) from other people’s project 
folders.

“Checking Avid Assets 
Out Using the Interplay 
Window” on page 46.

“Checking Avid Assets 
Out Using Interplay 
Access” on page 48.

 Refer to the documentation that came with your editing 
application for details on working with projects in Interplay.

 Use Interplay Media Services to offload heavy computational 
work and free up resources on your machine.

 Check in your sequence and bins to Interplay at regular 
intervals, and particularly before you finish your editing 
session, either by using the correct Interplay Folder setting or 
by dragging-and-dropping to the correct folder. 

“Checking Avid Assets In 
to the Interplay Database” 
on page 48.

 Use reservations to protect material against accidental 
deletion.

“Understanding 
Reservations” on page 51.

 Learn some basic rules about what you should and should not 
do in an Interplay environment.

“Dos and Don’ts for 
Editors Working with Avid 
Interplay” in the Interplay 
Help.

 Check the Unchecked-in Avid Assets/your username folder 
for any unchecked-in assets. Delete any assets (media, 
effects, and so on) that you no longer require.
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Configuring Interplay Settings on the Editing 
Workstation

You need to specify three Interplay settings before you can view or use remote assets:

• Interplay Server: Use this setting to specify the computer name of the Interplay Server. 
This is a Site setting, so it applies to all users and projects on a particular system. You 
can override this setting in the Interplay Login dialog box.

• Interplay User: Use this setting to specify the Interplay user account to use when 
logging into Interplay. This is a User setting, so it is specific to the Avid user. You can 
override this setting in the Interplay Login dialog box.

• Interplay Folder: Use this setting to specify where assets are checked into the Interplay 
database when you use menu commands, automatic checkin, or Frame Chase capture. 
This is a Project setting, so it applies to all users working on a particular project.

You need to log in to the Interplay database through the Interplay User setting before you 
can specify the Interplay Folder setting.For information on managing users, see the Avid 
Interplay Engine and Avid Interplay Archive Engine Administration Guide.

To configure Interplay settings:

1. Start your Avid editing application.

2. Click the Settings tab in the Project window.

3. Double-click Interplay Server.

4. In the Interplay Server Name text box, type the computer name or IP address of your 
Interplay server, and then click OK.

It is important to type the correct computer name or IP address. This is the location 
where the editing system looks to access the database and to check in and check out 
Avid assets.

5. In the Settings list, double-click Interplay User.
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6. In the User Name text box, type a user name.

This name must be a known user on your workgroup system.

7. Select “Automatic Login at Project Selection” if you want to log in to the Interplay 
database automatically every time you open a project.

If you do not select this option, you must open this dialog box when you want to access 
the database.

8. Click Login to establish the connection to the Interplay database.

The Interplay Login dialog box opens, with the server name you specified in the 
Interplay Server Settings as the Host Name.

9. In the Interplay Login dialog box, type your password, and click OK.

When the blinking yellow light in the upper left of the dialog box turns green, you are 
connected to the Interplay database and the dialog box closes. If you cannot log in, see 
your system administrator.

10. Double-click Interplay Folder.

11. Click the Set button, and a directory tree is displayed for the Interplay database that you 
logged in to. 

12. Select a folder to use as the default Interplay Root Folder for your project and click OK.
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The Interplay Folder setting defines where assets are checked into the Interplay database 
when you use menu commands, automatic checkin, or Frame Chase capture. (This 
setting does not apply when you manually drag media from a bin and drop it in a folder 
in the Interplay Window.) Interplay checks media in to a subfolder of the folder you 
specify in this dialog box. The subfolder is named after the bin whose assets you are 
checking in. 

13. (Option) Select “Append project to directory path” if you want Interplay to create a 
folder with your project name in the Projects folder.

This is the default setting. If this setting is selected, an Interplay folder named after the 
project contains subfolders named after the bins in the project.

14. (Option) Select “Verify directory path on first checkin.”

This is the default setting. If this setting is selected, a message box confirming the path 
is displayed the first time you check in from a bin. 

15. Click OK. 

Working with Interplay and Remote Assets
With Avid Interplay, users can share assets through folders that are managed by the Interplay 
database and accessible to all workstations in the Interplay environment. 

If your workflow includes checking in bins from an Avid editing application, you can set up 
your editing project so that checkins you perform automatically create corresponding folders 
on Interplay. Subfolders for each bin are created inside a folder for the project. Depending 
on the organization of your Interplay database, the project folder is usually located in the 
Projects directory on Interplay.

The following illustration shows the Project window alongside an opened bin from an Avid 
editing project, and the corresponding folder in the Interplay Window.
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Top: the Project window and opened bin from an Avid editing application. Bottom: the corresponding folder in 
the Interplay Window.

The project folder and its subfolders also contain project settings that primarily govern 
media acquisition — for example, frame rates, formats, and target workspaces. For more 
information about creating and managing projects in an Interplay environment, see Avid 
Interplay Best Practices.

From an Avid editing application you can use the Interplay Window to browse and open 
folders in the Interplay database. You can also use Interplay Access to browse and open 
project folders. Interplay Access includes advanced search features and other database 
features.
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You can work directly with assets in the Interplay Window, or you can copy (check out) 
assets to a bin in an Avid editing project. The bin then contains local copies of the remote 
assets. You can modify the local copy of an asset, but the changes remain local until you 
save the changes (check in) to the database.

You can check assets in and out in several different ways:

• Check assets out by dragging them from the Interplay Window or from Interplay Access 
.

• Check assets in by dragging them to the Interplay Window or by using one of several 
menu commands .

n Avid Interplay manages two kinds of assets: Avid assets, which are assets that are created by 
Avid applications (master clips, subclips, and so on) and file assets, which are assets that are 
created by other applications. When you work with Interplay from an Avid editing system, 
you can work only with Avid assets. You can use Interplay Access to work with both Avid 
assets and file assets. For more information, see the Avid Interplay Access User’s Guide.

Creating Avid Editing Projects in an Interplay 
Environment

One of the biggest decisions you will make regarding your workflow is the location of the 
projects and bins created by the editing applications. A predictable folder structure allows 
for the following: 

• Creates an easily maintained folder structure in the Interplay database

• Makes it easy for editors and other users in the organization to locate assets that are used 
by different projects

• Makes it easier for the Administrator to delete older projects on the Avid editing 
systems

This section covers the basics of creating a project structure that is easy to maintain in an 
Interplay environment.

Creating Projects

In a large Interplay environment it is important to locate Avid editing projects in areas that 
are easily accessible by the Administrator that has to delete the projects. This section 
describes the options for choosing a location for newly created projects folders. 
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When you start the editing application, the system displays the project log in window. From 
this window, you can create a project that is either Private, Shared, or External. See in the 
Interplay Help for more information on project types.

The best choices for a shared structure are either Shared or External. These types of projects 
are created in a common location, making it easier for the Administrator to locate and delete 
old projects.

n Any user can create or delete a project via the editor. Keep your project structure consistent 
to make the Interplay database easy to maintain.

If you are working with projects created on local drives, then note the following:

• A local project resides on the C: drive of the Avid editing system.

• If the connection between the Avid editing system and shared storage is lost, the project 
and its contents are unlikely to become corrupt as a by-product.

• You cannot login to the project from another workstation. You (or other users) must go 
to the Interplay Projects folder to locate the contents created in this project.

• From an administration standpoint, you must clean these projects up or archive them 
from each editing system. At a large site this can become time consuming and needs to 
become part of the Administrator’s workflow.

Private

A Private Project is stored locally. It can be accessed only by the user currently logged on to 
the editing machine. On a Windows system, a Private Project is always stored under the 
user’s Documents directory. An administrator may be able to access this project if they have 
read/write permission to the user’s directory.
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Shared

A Shared Project is stored locally. It can be accessed by any user that can log on the editing 
machine. On a Windows system, a Shared Project is always stored in the machine’s Shared 
Documents directory.

Private Project - under the My Documents/Avid Projects folder

Shared Project - under the Shared Avid Projects folder
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External

An External Project can be saved to any directory, either local or remote. Depending on the 
file-system permissions set on the selected folder, other users or an administrator may or 
may not be able to access the project. The external option is particularly useful when you 
want to save the project on shared network drive to make project maintenance easier.

n Avid does not support sharing bins in an Interplay environment. If you create projects on 
shared storage, do not allow editors to work in the same bin at the same time. This can result 
in data loss or media corruption. Instead of sharing bins, editors should use the Interplay 
Window to collaborate and share material.

Interplay Settings in the Editing Application

The Interplay Folder setting defines where the Avid editing application checks files into the 
Interplay database. After you open a project you can specify several Interplay settings, 
including the Interplay Folder. To access the settings, open the Settings scroll list in the in 
the Project window. The following table lists the Interplay-related settings.

External Project - the editor can specify the location

Option Description

Interplay Server (Site Setting) Specify the name of the Interplay Engine for the environment. If the site 
has an Interplay Engine Cluster, this is a virtual name that will log in to the 
active node.
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Defining the Interplay Folder Setting

The Interplay Folder setting defines where assets will be checked into the Interplay database. 
You need to define the location for each project. The examples in this chapter assume that 
you are using the Projects folder in the Interplay database. The following illustration shows 
the setting defined for the Projects folder. Use the Set button to define the location.

Interplay User (User Setting) Specify the name of the default Interplay user (if applicable) and check the 
Automatic Login at Project Selection checkbox. This does not auto-login 
to Interplay, but prompts the user to do so after logging in to their project.

Interplay Folder (Project Setting) Interplay organizes assets and media by folders. The default checkin folder 
must be set on each Avid editing application. 

By default, the folder path is empty. The Interplay database Projects folder 
is a good location to use. This will check the assets into a folder with the 
name of the bin inside the folder for the project. Click the Set button to 
navigate to the directory you want to use. After you select the Projects 
folder, the Interplay Folder Settings dialog box will display the following:

Projects/<project>

Dynamic Relink This setting is utilized in MultiRez environments, to specify the working 
and target resolutions for the Avid editing applications. The term MultiRez 
refers to having a single master clip associated with multiple resolutions. 
For additional information, see the Help for your Avid editing application. 

Media Services This setting specifies the Media Services Engine information. This allows 
the editor to submit Transcode, Pro Encode, or Archive jobs to the Media 
Service broker to hand off to the provider. When logged in to Media 
Services the client can submit the jobs using the File menu options or by 
right-clicking assets in a bin. You need to specify that Media Services are 
available, the Host name of your Media Services Engine, and a valid 
Interplay login account.

Option Description

Projects folder
selected

Click the 
Append project 
checkbox.
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The following illustration shows a folder for a project named “The Big Swell” created in the 
Projects folder. The folder was created automatically when the editor checked the first bin 
into Interplay using the Check in Bin to Interplay command. The system automatically 
created both folders and checked in the assets into the folder. 

For a Day-of-the-Week workflow, use the Projects\<project> setting in the Interplay Folder 
Setting window. Then, when multiple editors work in the 01Moday project, there will be one 
01Monday folder populated by the bins from each system. This keeps the organization easier 
to maintain.

To instruct the system to automatically check in bins when the editor closes the application, 
select the Bins option in the Editor Database Settings window in the Avid Interplay 
Administration tool. The default is to ask the editor before checking in the bin.

Defining the Media Creation Settings

Use the Media Creation dialog box to define where you want the Avid editing application to 
store newly created media.This is usually a workspace on shared storage that is monitored 
by the Interplay Media Indexer High Availability Group.

To define the Media Creation settings:

1. Click the Settings tab in the Project window of the Avid editing application.

2. Double-click Media Creation.

3. (Option) On the Drive Filtering and Indexing tab, click Auto-index local drives as they 
come online.

4. Click the Capture tab.

5. Select the video resolution and shared storage workspace for capturing new material.

Folders created by 
checking in the bin

Checked in assets
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6. Select the options for the other tabs (Import, Render, etc.).

Logging in to Interplay and Opening the Interplay 
Window

If you configured the Interplay User settings to log in to the database when you select your 
project, the Interplay Login dialog box opens when you start your Avid editing application. 
If you did not select this option, then you must open the Interplay User settings before 
logging in to the database.

After you log in, you have the option of opening the Interplay Window.

n You must be logged in to the Interplay database to work with remote assets. .

To log in and open the Interplay Window:

1. If your Interplay User settings are not configured to log in when you start a project, do 
the following:

a. In the Settings list, double-click Interplay User.

b. Click Login to establish the connection to the Interplay database.
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2. In the Interplay Login dialog box, type your password, and click OK.

When the blinking yellow light in the upper left of the dialog box turns green, you are 
connected to the Interplay database and the dialog box closes.

n You can override the Host Name and User Name settings in the Interplay Login dialog box.

3. If an Interplay Folder path is not set, the Interplay Folder setting dialog box is displayed. 
Set the path and other options and click OK. .

4. (Option) Select Tools > Interplay Window.

The Interplay Window opens.

Connecting to the Media Services Engine from an 
Avid Editing Application

To connect to the Media Services Engine:

1. In the Avid editing application, select Media Services from the Settings list.

The Media Services Settings dialog box opens.
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2. Fill in the following sections:

- Select the “Media Services are Available” option.

- Broker — Type the name of the system running the Media Services Engine.

- Type your user name and password. This user name can be one set up explicitly in 
Media Services Engine by the Media Services administrator. It can also be any valid 
Avid Interplay user name. For example, you can use the same user name and 
password that you use to connect to the Interplay Window.

- Shared Storage — Leave this field blank. This setting is only used for setting up 
Avid Interplay ProEncode.

- Email address — You can use this option if your Media Services Engine is set up 
for e-mail notification.

3. Click OK.

Checking Avid Assets Out Using the Interplay 
Window

You can copy assets from the Interplay database to a bin. This process is called checking out. 
Checking out assets from the Interplay database creates a local copy of the assets but does 
not create a local copy of the associated media. When you check the assets back in to the 
Interplay database, Interplay looks for any changes to the assets and copies the changes back 
to the database. 

n You can load clips directly from the Interplay Window. See “Editing with Avid Assets in the 
Interplay Window” in the Interplay Help.
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To check Avid assets out of the Interplay database using the Interplay Window:

1. Start your Avid editing application, and either create a new project or open a bin in an 
existing project.

2. Log in to the Interplay database.

3. Select Tools > Interplay Window.

4. Navigate to the project containing the master clips and sequences (assets) you want to 
use, and click the folder that contains the assets.

The Interplay Window displays the Avid assets in the selected folder.

5. Click the assets you want to check out, and drag them to your bin.

The bin displays the clips and sequences.

If you check out an asset and modify it (for example, you edit a sequence), and check 
out the asset again without checking in the modified version, the following warning is 
displayed: 
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This message could also appear if another user has checked in a modified version of the 
asset after you checked it out. Click “Update anyway” to overwrite the local version 
with the version on the database, or click “Keep local modifications” to preserve the 
local version. 

Checking Avid Assets Out Using Interplay Access

When you are working with an Avid editing application, you might want to use the advanced 
search in Interplay Access to look for particular Avid assets. After finding the assets, you 
can drag them from Interplay Access into a bin (checking out the assets), which creates local 
copies of the assets (but not the media).

If you then modify the asset and want to save the changes in the database, you must use the 
menu commands in your Avid editing application to check the asset back in to the database. 
You cannot drag assets from a bin to Interplay Access.

To check Avid assets out of the Interplay database using Interplay Access:

1. Start your Avid editing application, and either create a new project or open a bin in an 
existing project.

2. Log on to the Interplay database.

3. Open Interplay Access and browse or search for the assets you want.

4. Select the assets you want to use and drag them to a bin.

The Avid assets are checked out from the Interplay database. A link is created to the 
asset, and the bin displays the assets you checked out.

Checking Avid Assets In to the Interplay Database
The process of adding Avid assets to the Interplay database or updating Avid assets already 
in the database is called checking in. There are two basic ways to check in Avid assets:

• By using menu commands or automatic checkin

• By dragging assets to the Interplay Window
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When you use a menu command or automatic checkin to check in assets, the Interplay 
Engine checks them into a subfolder named after the bin, in a folder that you selected in the 
Interplay Folder settings. When you use the drag-and-drop method for checking in assets, 
you can select any appropriate Interplay folder to store your assets.

The following table describes the methods available for checking in Avid assets.

n By default, a 24-hour reservation is automatically placed on a folder whenever a new or 
modified Avid asset is checked in to the Interplay database from a bin. An Interplay 
administrator sets the default duration of the reservation in the Application Database 
Settings in the Avid Interplay Administrator. 

Method Description

Check in assets by 
checking in a bin

You can check in assets to a bin using the Bin > Check In Bin to Interplay command or the 
Bin > Check in All Open Bins to Interplay command. These commands check in the 
following items:

• Items that have been modified since they were last checked in or out

• Items that have been added to a bin.

• Items that do not exist in the database because they were deleted from the target folder 
(the folder into which you are checking in)

If an item exists in the database but does not exist in the target folder (the folder into which 
you are checking in), a link for the item is created in the target folder. Adding a link takes 
much less time than performing a full checkin.

n The command File > Check In Open Bins in Project performs the same actions as 
Bin > Check In All Open Bins to Interplay.

Automatically 
check in assets by 
closing a bin

Automatic checkin is a setting enabled in the Application Database Settings in the Interplay 
Administrator that lets you check in assets when closing a bin, a project, or your Avid 
editing application. Automatic checkin is optimized to work more quickly than the menu 
commands. If a bin contains any new or modified items, it is processed exactly as when you 
use menu commands described above. If there are no new or modified items in a bin, no 
items in the bin are checked in. In this case, automatic checkin will not detect if any items 
have been deleted from the bin’s database folder. 

Force a check-in 
of selected items

If you want to make sure items are checked into the database (including items that have not 
been modified and items that do not exist in the database), select the items, right-click, and 
select Check In To Interplay.

Select assets and 
drag them to the 
Interplay Window

This command also forces a checkin of all selected items.
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To add Avid assets from your bin to the Interplay database by using menu commands:

1. Open the bin that contains your clips or sequences.

2. Log in to the Interplay database if you have not already done so.

3. Do one of the following:

t To check in all Avid assets in a bin, select the bin and then select Bin > Check In 
Bin To Interplay or File > Check In All Open Bins to Interplay, or right-click the 
Bin Fast menu and select Check In Bin To Interplay.

t To check in Avid assets in all open bins, select Bin > Check In All Open Bins to 
Interplay or right-click the Bin Fast menu and select Check In Bin To Interplay.

t To check in one or more Avid assets, select the assets and select File > Check In To 
Interplay or right-click and select Check In To Interplay.

t To check in a sequence for use in a Pro Tools project, select File > Check In to 
Interplay for Pro Tools or right-click and select Check In to Interplay for Pro Tools.

The Interplay Engine checks in the assets to a subfolder of the folder you specified in 
the Interplay Folder Settings.

4. (Option) You can set an option to display a message box that asks you to verify the 
folder into which the assets will be checked in.

t Click OK to accept the directory path and complete the checkin.

t Change Setting to cancel the checkin and open the Interplay Folder Settings dialog 
box.

t Click Cancel to cancel the checkin.

The message box is shown the first time you check in from a project. 

To add Avid assets from your bin to the Interplay database using drag and drop:

1. Open the bin that contains your clips or sequences.

2. Log in to the Interplay database if you have not already done so.

3. Select Tools > Interplay Window.
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4. (Option) Right-click the Projects folder in the Interplay Window, select Create a New 
Folder, and then type a name for the folder.

5. Select one or more items in the bin and drop them in a folder in the Interplay Window.

Understanding Reservations
Reservations are time-based protections that authorized users can set on Interplay database 
folders. Usually reservations are assigned by a user with appropriate privileges using 
Interplay Access. By default, a 24-hour reservation is automatically placed on a folder 
whenever a new or modified Avid asset is checked in to the Interplay database from a bin.

n The default duration of automatic reservations is set in the Application Database Settings in 
the Avid Interplay Administrator.

When you reserve a folder, the system adds a Reservation icon to the folder and sets the 
reservation on all of the Avid assets in the folder. The reservation protects the assets — 
which include sequences, master clips, and all the media files and metadata files that are 
associated with them — from deletion and moving.
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Reservation icons on folders in the Media Directory panel

Only the owner of a reservation or the Administrator can remove the reservation or delete or 
move the contents of a reserved folder. Since folders can have reservations set by multiple 
users with multiple end dates, you might not be able to move or delete the asset even if you 
placed a reservation on it. Unless one of the reservations expires or is revoked by the user 
that created it, only your Interplay administrator can move or delete the asset.

For more detailed information on reservations, see “Setting Reservations” in the Interplay 
Help.



3 MultiRez Workflow in an Interplay 
Environment

MultiRez (a term derived from "multiple resolutions") lets you capture media from a single 
master clip that can be associated with multiple files of that same media at different 
resolutions. Using Avid AirSpeed Multi Stream, you can simultaneously capture 
low-resolution and high-resolution material to an Avid Unity. These low-res files are known 
as proxies. Interplay automatically matches and tracks the low-res proxies to their high-res 
versions.

To save storage space, a media manager or Interplay administrator usually archives most of 
the high-res media to a robotic tape library. After archiving, the media manager deletes the 
online high-res media and maintains the low-res media online to allow editors to work with 
it. To preserve the network bandwidth, the administrator at your facility can also restrict user 
access to the high-res media.

It’s more efficient to use the low-res proxies when editing the media. During the finishing 
stages, you can then restore portions of high-res media used in the sequence, and conform 
the proxy edits into a composition that refers to the high-res media.

The following table describes the main stages of the workflow.

Step Description

1. Capture media Capture media at high-res and low-res.

2. Archive high-res media Copy high-res media to tape and delete it from online shared storage.

3. Edit sequence Work with low-res proxies in the editing application

4. Restore high-res media Use Interplay Access to search for clips and restore only portions 
used in the sequence. You can also restore clips directly from the 
editing application.
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Preparing Interplay for MultiRez

Several Interplay Media Services must be installed in order for you to perform critical tasks 
in a MultiRez workflow. For more information about setting up Media Services, see the 
Interplay Help.

To utilize these services, you then need to set up a number of Media Service Profiles. These 
profiles define the tasks that the Media Services perform. The following section explains 
how to create profiles, and gives example profiles for 720p and 1080p projects.

Creating Profiles for MultiRez Services

A MultiRez workflow requires the following profiles:

• Transcode high-res media to a proxy

• Archive the high-res media

• Restore high-res clips from the archive

• Restore portions of high-res media that are used by clips in a sequence.

To use the Media Services application to create a profile:

1. In Interplay Access, select View > Media Services Status. 

2. Click the Profiles tab and select the Provider from the Service menu in the top left-hand 
window. 

The following illustration shows the Avid Interplay Transcode Service provider 
selected.
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3. Click Add and type in a name for the new profile.

4. Add the appropriate values and click Save. 

For more information on creating profiles, see the Interplay Help or the Avid Interplay 
Media Services User and Setup Guide.

Example profiles for 720p and 1080p projects are listed below.

n In the following examples, AVCIBP-BLL3.0 60 is an NTSC proxy for 720p media. The 
equivalent PAL proxy is AVCIBP-BLL3.0 50. AVCI stands for AVC intra-frame.

Transcode Profile Example

The following transcode profiles create low-res proxy video and compressed audio.

Parameter 720p 1080p

Mode Whole Whole

Priority 50 50
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Archive Profile Example

The following profiles archive high-res video to the specified destination. Only the specified 
video resolutions are archived.

Full Restore Profile Example

The following profiles restore high-res media in their entirety. Only the specified video 
resolutions are restored. Note that in this profile, the Partial checkbox is not checked,

Partial Restore Profile Example

TargetAudioQuality MPEG1LAYER2 MPEG1LAYER2

TargetAudioTrackMapping blank blank

TargetVideoQuality AVCIBP-BLL3.0 60 DNxHD 1080 36

VideoTimeCodeFormat FUTURE_USE FUTURE_USE

Workspace Broadcast Broadcast

Parameter 720p 1080p

Parameter 720p 1080p

Destination_Path AvidAM/Catalogs/WW/720p AvidAM/Catalogs/WW/1080p

Partition DETArchive% DETArchive%

Priority 50 50

TargetVideoQuality DNxHD 720 60-75-145 1:1MXF 10bit 1080p

Parameter 720p 1080p

Destination_Path AvidWG/Catalogs/HighestFull AvidWG/Catalogs/HighestFull

Destination_Server a51wg-eng01 a51wg-eng01

Destination_Workspace Transfer Transfer

Partial Not checked Not checked

Priority 50 50

TargetVideoQuality DNxHD 720 60-75-145 1:1MXF 10bit 1080p
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The following profiles restore portions of high-res media used in the sequence. Only the 
specified resolutions are restored. You could also select “Highest” and restore the highest 
available resolution.

Acquiring Media at Multiple Resolutions
In an Avid Interplay environment, you can have multiple resolutions of the same media. 
These can be acquired in several ways. If you have AirSpeed Multi Stream, you can ingest 
both high and low-res media simultaneously. You can also first create master clips with 
high-res media, and if your hardware permits it, you can re-capture these clips as low-res 
proxies. If multi-rez batch capturing is not supported, you must use your Avid software to 
transcode to a low-res proxy.

Batch Capture Multiple Resolutions

• In a newsroom environment, you can use CaptureManager™, one or more AirSpeed® 
systems, and the Avid Interplay Low-Res Encoder to simultaneously capture high-res 
and low-res versions of the same master clip.

• You can capture more than once from the same tape at different resolutions and 
associate the new resolutions with the same master clip. You can batch capture from any 
system that has access to the master clip and original tape. For example, you can batch 
capture from the same system that acquired the media originally, or you can use Avid 
Interplay to check out a clip on another system and perform the batch capture there.

Parameter 720p 1080p

Destination_Path AvidWG/Catalogs/HighestPartial AvidWG/Catalogs/HighestPartial

Destination_Server a51wg-eng01 a51wg-eng01

Destination_Workspace Transfer Transfer

Partial Checked Checked

Priority 50 50

TargetVideoQuality DNxHD 720 60-75-145 1:1MXF 10bit 1080p
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Batch Import Multiple Resolutions

• When working with file-based media, you can batch import in multiple resolutions, 
while associating all resolutions with the same master clip.

Capture High-Res and Transcode to Low-Res

• You can use the Avid Interplay Media Services from within the Avid editing application 
to capture at a high resolution and then use Avid Interplay Transcode to create different 
resolutions of the same clip. 

• You can use the Consolidate/Transcode command within the Avid editing application to 
create different resolutions of the same master clip. If you consolidate, the application 
creates a new clip for each resolution. If you transcode, you have the choice of 
associating the new resolution with the original master clip, or creating a new clip.

• In all cases, even if a new master clip is created, the dynamic relink feature always 
relinks the clip to the source media.

Understanding How Clips are Associated with Multiple Resolutions

In a MultiRez environment, relinking is source based. That is, your Avid editing application 
relinks a clip to its media according to the source of the clip rather than the name of the clip.

Whenever you create a new tape or import a file, your Avid editing application creates a 
unique source ID that is used by your Avid editing application and is not visible to users.

You create a new tape by clicking the New button in the Select Tape dialog box, entering a 
name for the tape, and clicking OK.
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Your Avid editing application then associates the new source ID with each clip that you 
capture from that tape.

Example of source ID association: the source ID your Avid editing application assigns to a tape (for example, 
12345) is also associated with each clip and media file you capture from that tape

Later, if you recapture a clip at a different resolution, make sure to select the tape name 
originally associated with that clip. If you select the original name and use the original tape, 
your Avid editing application associates the new media with the original master clip. In an 
Avid Interplay environment, this source-based association is the basis for dynamic relink.

n Avid CaptureManager also uses a source ID to associate a master clip with any media 
created at the same time, such as a clip captured with two resolutions in a dual-ingest 
configuration. However, instead of associating all clips from the same tape with the same 
source ID, CaptureManager creates a new source ID every time it captures a new clip.

For details of the possible ways that master clips and media files might be associated with 
one another in a MultiRez environment, see “Options for Clip and Media Association” in the 
Help for the Media Composer family”.

Guidelines for MultiRez Tape Management

When working in a MultiRez workflow, it is important to name tapes properly. In particular, 
you should keep the following in mind:

• Whenever you create a new tape, your Avid editing application generates a new source 
ID, even if the name you type for the new tape exactly matches that of an existing tape. 
You cannot dynamically relink media that does not share a source ID.

• Do not use the same name for two different tapes or different names for the same tape. 
This might cause incorrect media association. 

• Do not use the default tape name “New Tape.”

Capturing Media to Interplay Folders

By using the Interplay Window to connect to the Interplay database, you can capture media 
directly to an Interplay folder. You can capture to any folder currently open in the Interplay 
Window.

DV

Tape A
Source ID: 12345

Clip 1
Source ID: 12345

Media: 1:1
Source ID: 12345
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n You can open multiple Interplay folders by using multiple tabs in the Research panel of the 
Interplay Window. For more information, see “Opening Multiple Tabs in the Interplay 
Window” in the Help for the Media Composer family.

To capture media to an Interplay folder:

1. Select Tools > Interplay Window.

2. Navigate to the Interplay folder to which you want to capture media, and click the 
folder.

The Interplay Window displays the Avid assets in the Interplay folder.

3. Select Tools > Capture.

The Interplay Folders selection button (top) and the Bin menu (bottom) in the Capture tool

4. Set up the Capture tool. 

5. Click the Interplay Folders selection button.

6. Click the Bin menu, and select an open Interplay folder.

7. Start capturing as usual.
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For information on different methods and procedures for capturing media, see 
“Capturing Media” in the Help for your Avid editing application.

Batch Capturing Media at a Different Resolution

Batch capturing lets you create different resolutions of media through the same process that 
the original media was captured from hardware. To perform a batch capture, you must have 
a master clip containing either a clip log or previously captured media.

n You can only create one new resolution at a time using batch capture. To capture multiple 
resolutions at the same time (ie: high-res and a proxy simultaneously), use the Interplay 
Low-Res Encoder. See the Interplay documentation for more information.

To batch capture a different resolution:

1. Prepare your system for batch capturing, as described in the Help for your Avid editing 
application. Be sure to select the new resolution you would like to capture in the Media 
Creation settings Capture tab or in the Capture tool.

2. Select the clips or sequences you want to batch capture.

3. Select Clip > Batch Capture.

The Batch Capture dialog box opens.

4. Deselect “Offline media only” to specify that you want to re-capture media that is 
already online, in addition to offline media.

The “Discard original local media” option appears.

5. Deselect “Discard original local media” to keep the original resolution of your clips or 
sequences.

6. (Option) Select “Extend handles beyond master clip edges” to allow the handles to 
extend before the beginning and after the end of the original master clip.
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When you batch capture, deselecting this option prevents capturing across a 
discontinuous timecode error.

7. Click OK.

If you have not loaded a tape, your Avid editing application prompts you to load the 
original tape.

8. Load the tape into the tape deck, and click Mounted.

A dialog box opens.

9. Click OK to confirm the tape and deck entries and to begin the capture process.

Your Avid editing application captures each clip from the tape, in start timecode order.

c When you batch capture, make sure to accept the original tape name so that the new 
media files are associated with the same source as the original media files.

Batch capture does not create any new master clips. As new media files are created, the 
Media Indexer adds them to its database, and the original master clip is associated with 
additional media files. Media files in multiple resolutions are indicated by black dots in 
the appropriate bin columns. The following illustration shows a clip originally captured 
at 15:1s and batch captured at 1:1 (uncompressed).

n For information about displaying bin columns for MultiRez, see “MultiRez Bin Headings” 
in the Help for the Media Composer family.

Batch Importing File-Based Media at Different Resolutions

Using Batch Import, you can import file-based media at different resolutions. To perform a 
batch import, you must have a master clip that has the media imported in another resolution.

To batch import a different resolution:

1. Mount and connect to any removable drives that hold the original file-based media.

2. Open the bin, and select the imported master clips and sequences you want to reimport.

3. Select Clip > Batch Import.
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A message box opens.

4. Click All Clips to import new resolutions for media that is already online, in addition to 
offline media.

5. In the Import Target area, select the desired resolution and storage location.

6. In the Import Options area, select “Keep existing local media” and any other options.

7. Click Import.

Your Avid editing application imports the files and creates media in the resolution you 
specified. The original media file is preserved, and the master clip is now associated 
with an additional resolution.

Transcoding Media to Low-Res Proxies

Transcoding allows you to convert media to any Avid supported format. Use the transcode 
operation only if your hardware does not support batch capturing in a desired proxy format. 
Transcoding is only useful for creating lower resolution versions of high-res media; it is not 
recommended that you transcode from low-res to high-res.

To transcode a clip using your Avid editing application:

t Right click the clip in the bin and select Consolidate/Transcode.

n The Consolidate/Transcode operation is the only way to create proxies from RGB media.

To transcode a clip using the Interplay Transcode service, do one of the following:

t In Avid Interplay Access, right-click the clip and select Transcode. Select the profile 
that has been created for this transcode and click Set.

t In your Avid editing application, right-click the clip in the bin and select Media Services 
> Avid Interplay Transcode Service. Select the profile that has been created for this 
transcode.

t Set up an Auto Transcode folder in Interplay Access and drag and drop clips to the 
folder.
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The Transcode service transcodes the clip and stores the media according to the instructions 
in the profile. The new media is associated with the original clip metadata. The following 
illustration shows an example of a low-res proxy in the Interplay Window. You can see that 
the current resolution for the clip is AVCIBP-BLL3.0.60. This is the Avid editing application 
representation for 720p/59.94 proxy media.

For information about configuring Transcode Profiles, see “Creating Profiles for MultiRez 
Services” on page 54. For additional information, see the Interplay Help or the Interplay 
Media Services Setup and User’s Guide.

n 720p proxy media can only be created using the Interplay Transcode service. The 
Consolidate/Transcode operation in your editing application does not support 720p proxy 
media in this release.

Archiving the High-Res Media

You can use Interplay Access or the Avid editing application to archive the high-res material. 
Both techniques use a Media Services profile as described in “Preparing Interplay for 
MultiRez” on page 54.

n You can also set up an Auto Archive folder and use Interplay Access to drag and drop files to 
archive into the folder. For additional information, see the Interplay Media Services Setup 
and User’s Guide.

To archive the high-res material:

1. Start Avid Interplay Access.

2. Select the asset that you want to archive from the online database. 

3. Select Tools > Archive or right-click the asset and select Archive.
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The Archive dialog box opens.

4. Select a profile from the Use Profile menu.

n Avid recommends that you use profiles for archiving, because profiles define many key 
settings such as target folders and archive partitions. For example, if you do not use a profile 
with an SGL archive implementation, the system uses the default SGL archive volume name. 
If this volume is not defined on the SGL system, the archive operation will fail.

5. (Option) Select “Launch Interplay Media Services Status window.”

6. Click OK.

The system starts the Archive operation. The following illustration shows the Media 
Services and Transfer Status tool with the archive operation in progress.

Select a Profile

Select a 
database
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7. (Option) For details about the job, select the job and click the Details button.

8. (Option) Navigate to the destination folder in the archive database and verify that your 
file has been archived.

The following illustration shows the clip in the Archive database.

Deleting the High-Res Media

After the high-res material is archived, you can delete the online version. Use the Delete 
dialog box in Interplay Access to select Avid assets for deletion. You have the option of 
deleting the assets only, the media only, or both assets and media. Delete only the high-res 

Archive in progress

Archive 
database
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media associated with the master clips; do not delete the master clips or the low-res proxies. 
For additional information on deleting assets and media, see the Interplay Access User’s 
Guide and the Interplay Best Practices Guide.

To delete the high-res media:

1. In the Interplay Access Content tab, select the assets you want to delete.

You can select multiple folders or clips for deletion. You can also delete folders by 
selecting them in the tree structure in the Folders pane.

2. Do one of the following:

t Right-click and select Delete.

t Press the Delete key.

The Delete dialog box opens, displaying information about the items you selected. It 
also displays the amount of disk space that would be freed if you delete the media files. 
No items are selected for deletion until you select them in the Delete dialog box.

The following illustration shows the results of selecting a master clip for deletion. The 
master clip is associated with both high-res and low-res media files but you are only 
deleting the high-res material. Leave the master clip and low-res material online.
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3. In the “Delete selected items” area, deselect the master clip as shown in the above 
illustration. Keep the associated media files box checked.

4. Specify the media that you want to delete by first selecting the resolutions you want to 
delete.

The Media Resolutions section of the dialog box lists all video resolutions and audio 
formats for the clips you selected, including media associated through the Dynamic 
Relink feature. All resolutions are selected by default. Deselect the low-res media so 
that they are not deleted. Keep the high-res media selected for deletion. In this example, 
DNxHD is the high-res media and is selected for deletion.



Editing with MultiRez Media

69

5. Select the mdia workspaces from which you want to delete media.

All workspaces that contain the selected media are listed and are selected by default.

6. Select whether to force the deletion of media files locked by an editor or to skip deletion 
of locked files.

These options are available only if the user has administrative rights or if they are 
enabled by an administrator. “Skip locked media” is the default. 

7. Select “Delete only media created with the selected clip or clips.” This ensures that you 
only delete the media that was originally created with the clip. 

n Beginning with Interplay v2.0, the “Delete only media...” option is selected by default.

8. (Option) Click Details to determine if any clips are reserved and possibly currently in 
use by an editor.

The Clips Reserved dialog box opens. Any clips with reservations are listed, along with 
information about the clips. If you have the proper privileges, you can override the 
reservations. Otherwise, click Cancel.

9. When you are ready to delete the files, click OK in the Delete dialog box.

The Delete in Progress dialog box displays the status of the deletion. 

10. When the delete operation is completed, click Done.

Editing with MultiRez Media

The editor can begin working with the media as soon as a low-res proxy is available. In fact, 
the archiving and deleting of the high-res material can take place in the background while 
the editor is working.

Understanding Dynamic Relink

Dynamic relink is a feature that lets you select which media you want to use when you are 
working in a MultiRez environment. Typically, you use low-res media for offline editing and 
high-res media for a final master. For instance, you can edit in SD and output in HD. 
Dynamic relink lets you control how your Avid editing application links your clips to the 
appropriate media.
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You specify two different groups of settings:

• Working settings are the settings you want to use while you edit the sequence:

For offline editing of a sequence, your editing application uses the resolution specified 
in the working settings. This is where you can specify a low-res proxy instead of 
high-res media so that you can work more efficiently, and save space on your online 
storage.

• Target settings are the settings you want to use for your final master:

When you finish the offline editing, the Send to Playback command automatically 
outputs the sequence in your target resolution and format. The clips in the sequence do 
not change — your Avid editing application dynamically relinks them to the media files 
in the target resolution.

You specify these settings in the Dynamic Relink Settings dialog box, which is available in 
the Settings list of the Project window. For more information, see “Using the Dynamic 
Relink Settings Dialog Box” in the Help for the Media Composer family.
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The following illustration shows a bin and a sequence. The first version of the sequence 
shows the clip in the working resolution (15:1s) and the second version shows the same clip 
in the target resolution (1:1). The clip name is the same in both cases, but the resolution of 
the clip (as shown in the text on the clip) is different.
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Left: clip associated with working and target resolutions. Top right: sequence with clip in working resolution 
(15:1s). Bottom right: sequence with clip in target resolution (1:1).

n To display the clip resolution for each clip in the Timeline, click the Timeline Fast Menu 
button and select Clip Text > Clip Resolutions.

Workflow: Editing a Film or HD Project using MultiRez

This workflow describes how to link to media of different resolutions in the context of Film 
or HD project. The steps involved are:

• Opening an HD project and checking out the clip

• Setting Dynamic Relink to work with the low-res proxy

• Performing a partial restore to restore the portions of the clip used in the sequence.

• Using Dynamic Relink to start working with the high-res media.

 Most of the same steps apply when working with RGB and 720p media.
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To create a Film or HD Project:

1. When you create the project, make sure it supports the resolution you want to use. For 
24p Film and HD projects, select 1080p/24 or 1080p/23.976 depending on the rate at 
which your footage was shot. If your source media is film-based, check the Film box 
and select the Film Type. The following illustration shows the Project selection for a 
24p Film project used in this example.

2. (Film only) Immediately after creating your project, set up the Film and 24P settings 
under the settings tab.

To check out the clip and set Dynamic Relink:

1. In your Avid editing application, select Tools > Interplay Window.

2. Locate the clip in the Interplay Window and drag it to the bin.

The following illustration shows the clip in the Interplay window and the bin. Notice 
that both the high-res and low-res are online.
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High-res and low-res media both online (filled circles) for the clip in the bin

3. Open the Dynamic Relink dialog box and set the working resolution to the low-res 
proxy. 

The following illustration shows the Dynamic Relink values used in this example to link 
to the low-res media.
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4. Edit the media into a sequence.

By default, whenever you load clips into a monitor or the Timeline, they are linked to 
media that matches the working settings.

The following illustration shows the bin after the sequence is created. In this example, 
the administrator has already archived and deleted the high-res material. The MultiRez 
bin columns show that the high-res media is completely offline.
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The high-res media is now offline (empty circle in the bin)

5. (Skip this step if the administrator did not archive the high-res media)
When you are finished editing the sequence, restore the portions of high-res material 
used in the sequence from the archive.

The following illustration shows the bin after the partial restore operation is completed. 
The MultiRez bin columns show that the high-res media is now partly online because 
only the required portions of the high-res media are restored.

After the partial restore, the high-res media is partly online (half-filled circle)

6. In the Target settings, set the project format for output. (This also determines the 
resolutions that are available in the Dynamic Relink target settings.) You can set this 
format independently of the format set in the Format tab of the Project window.

Media captured in this format will be used during output.

7. If you need to create effects that require you to view the high-resolution media, check 
the Override Working Settings with Target Settings box in the dynamic relink window to 
dynamically relink clips to media that matches the target settings.

c Render effects only when you have linked to the target settings. This should be done as 
the last step before output. If you return to the working settings, any media files 
created by rendering effects (precomputes) will not dynamically relink in the target 
resolution.
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8. Open the Dynamic Relink dialog box and set the working resolution to the high-res 
version. 

The following illustration shows the Dynamic Relink values used to link to the high-res 
video and audio. In this example, a specific resolution was chosen.

9. Render effects in the target resolution if necessary.

n You can use the MultiRez button and MultiRez clip coloring to give you the necessary 
indications that you may not have media that matches the target settings.

10. Output your final master by doing one of the following:

t Create a digital cut.

t Use the Send to Playback command.
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When you perform a Send to Playback operation, your Avid editing application 
automatically renders effects and relinks your sequence to the target resolution.

c When you use the Send to Playback command, make sure you are using the target 
settings required by the playback device or Send to Playback fails.

Searching for High-Res Master Clips

Using Interplay Access, you can search for a sequence or master clip and choose to restore it 
from the archive. This example assumes that the high-res media is in the archive and the 
corresponding low-res proxy media is online.

• You can search the online database for clips meeting specific criteria, view the low-res 
proxy, and then decide which clips to restore them from the archive.

• You can also search the archive database directly for clips to restore.

To search the online database for clips:

1. In the Assets view, click the Search tab.

2. Click the Simple tab. If necessary, click the Search Conditions arrow to show the search 
criteria.
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3. Select a search root folder by doing one of the following:

t Use the Search Root button to select the archive database.

t Click a folder in the Tree view and drag it onto the Search Root button.

The Search root button displays the database or folder you selected to search.

4. Type the text or select the attributes and values you want to use for the search. In this 
example, the desired clip name contains the text “4hour”. It is a master clip, and it was 
created within the last month.

n If you do not select any criteria, the search returns all the records in the database.

5. Click the Search button.

The Search button changes to a Stop button which you can click if you want to stop the 
search. The results are displayed in the Search Results pane. They are visible until you 
close Avid Interplay Access or until you perform a new search. 

For additional information on searching and search criteria, see the Help for Interplay.

Search tab Search Root button

Search Conditions arrow

Simple tab

Search results
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To search for a clip in the archive database:

1. Connect to the archive database. For additional information, see “Connecting to the 
Archive Database” in the Interplay Help or the Interplay Media Services Setup and 
User’s Guide.

2. Click the Search tab in the Avid Interplay Access window.

3. Click the Search Root button.

The Choose Search Root dialog box opens.

Search RootSearch Tab
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4. Select the Archive database (e.g. AvidAM) and click OK.

5. Type the name (or a portion of the name) of the clip you want to search for and select the 
appropriate search criteria. 

6. Click the Search button.

The system displays the search results. In this example, one master clip in the archive 
database has the text “4HOUR” in its name.
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Restoring the High-Res Media

You can restore the high-res media using Interplay Access or using your editing application. 
Make sure the Media Services Engine application and Avid Interplay Archive service are 
connected. See “Verifying a Service Provider Is Connected” in the Interplay Help or the 
Interplay Media Services Setup and User’s Guide.



Editing with MultiRez Media

83

To restore an entire clip using Avid Interplay Access:

1. Right-click the clip in the Search Results area and choose Restore. You can also use the 
Tree view to locate the clip you want to restore.

The Restore dialog box opens.

2. Select a profile from the Use Profile menu. For information about profiles, see “Creating 
Profiles for MultiRez Services” on page 54.

3. Click OK.

The system performs the restore operation. You can use the Media Services Status 
window to view the progress and results of the restore operation.

4. (Option) Navigate to the destination folder in the Avid Interplay Access window and 
verify that the clip was restored.

5. Make sure Enable Dynamic Relink is selected to view the restored media.

Tree view Search results

Archive 
database
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To restore a sequence using your Avid editing application:

1. Verify that your Media Services Settings are properly configured, and that you are 
connected to a Media Services Broker.

2. Right-click the sequence in the bin and select Media Services > Avid Interplay Restore 
Service.

3. Select a profile that is set up to perform either a partial or a full restore and click OK.

If the profile that you chose is set up to perform partial restores, the application restores 
only the portions of clips that are in the sequence. Otherwise, the application restores all 
clips in the sequence in their entirety.

To restore a clip using your Avid editing application:

1. Verify that your Media Services Settings are properly configured, and that you are 
connected to a Media Services Broker.

2. Right-click the sequence in the bin and select Media Services > Avid Interplay Restore 
Service.

3. Select a profile that is set up to perform a restore and click OK.

The entire clip is restored from the archive.



4 Conforming Projects on Avid DS in an 
Interplay Environment

The Avid Interplay environment helps to manage and store media when you bring in 
sequences from Avid Media Composer to Avid DS for conforming. With Avid storage 
solutions, you can import the sequence with its media already in final resolution for 
finishing, such as adding special effects or color correction.

The following illustration shows a typical example of a basic workflow for storing, 
transferring, and conforming media in an Avid Interplay environment.

Checklist: Conforming Projects on Avid DS in an 
Interplay Environment

The checklist below provides a basic workflow for transferring and conforming media when 
Avid DS participates in an Avid Interplay workgroup environment. The administrator 
configuring the hardware and software components in the Interplay environment must 
follow the steps in the order listed to ensure that these components function successfully.

Step Refer to

 Before you begin, refer to specific information 
about workgroups in the Interplay environment.

“Workgroup with Shared Storage in an Avid 
Interplay Environment” on page 88.

 Install and configure the required hardware and 
software components for your workgroup:

• Avid Unity ISIS Client Manager

• Avid Interplay Access

Avid Unity and Avid Interplay documentation.

Configuring Avid DS on Unity:

 Install all Avid DS client workstations.

c Do not install any Avid DS software 
components (such as the indexing 
services) directly on Avid Unity.

“Installing your Avid DS Environment” in the 
Help for Avid DS.
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 Install Avid Unity client software on each Avid DS 
workstation that is connected to Avid Unity.

Avid Unity documentation.

 Install the latest updates for the Avid Unity 
software (if any).

Follow the online instructions to install this 
software update, then reboot your workstation.

Avid Download Center 
www.avid.com/support/downloadcenter/index.asp

 Create necessary folders on your storage. “Sharing Media” on page 91.

 On the Avid Unity, create a video workspace and 
an audio workspace for each Avid DS workstation 
(the RP workstation does not need a workspace).

Create a workspace for the video storage - 
\\server_name\workspace_name\video

Create a workspace for the audio storage - 
\\server_name\workspace_name\audio

Avid Unity documentation.

 If you need to share media with other Avid editing 
systems (Media Composer, Symphony), create 
additional workspaces where they can place media 
that will be shared with Avid DS (audio and video 
can be stored in the same folder). 

n These folders should only contain media 
that needs to be conformed and used by 
Avid DS, as there is no need to index all the 
offline media on an Avid editing system.

 To share MXF media, create the appropriate 
workspace.

“Sharing MXF Media” on page 94.

 To share OMFI media, create the 
appropriateworkspace.

“Sharing OMFI Media” on page 95.

 Use the Administration Tool to assign the 
permissions on each workspace. If some 
workstations need to share media, you can assign 
permissions for these workstations on the 
appropriate workspaces. (You should also give the 
RP workstations permission to each workspace).

Avid Unity documentation.

Step Refer to

http://www.avid.com/support/downloadcenter/index.asp
http://www.avid.com/support/downloadcenter/index.asp
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 Set up the Avid Unity Connection Manager on 
each Avid DS workstation to auto-launch.

The Connection Manager should always be left 
active on the Avid DS workstations. This utility 
will automatically map letters (or UNC paths in 
recent releases) and authenticate the specific user 
accounts listed in the Avid Unity Engine.

 Place your media in the designated workspaces. “Placing High-Resolution Media on the Storage 
Device” on page 95.

On the Avid DS system in the Interplay 
environment:

 Install Avid Interplay Access on each Avid DS 
workstation participating in the Interplay 
environment.

 Each client workstation needs to mount the 
required workspaces.

 In Avid DS, use the Storage Configuration tool to 
add a Unity storage connection to your local 
indexing service. 

Important: Do NOT use a drive letter or mapped 
drive letter, instead browse the network to the Avid 
Unity server, using only a UNC path to access your 
media folder on Avid Unity.

“Defining your Storage Areas within the Media 
Indexing Service” on page 96.

 Configure access to the media storage indexed by 
the Avid Interplay Media Indexer.

“Accessing Storage on Workstations in an Avid 
Interplay Environment” on page 102.

 Configure the Interplay Adapter. “Configuring the Interplay Adapter” on page 90.

Conforming projects and sequences:

 On your Media Composer/Symphony system, 
build the sequence and prepare it for export.

“Packing Up Projects on your Offline System” in 
the Help for Avid DS.

 Export the sequence to Avid DS by checking it into 
Interplay Access. 

“Exporting the Finished Sequence to Avid DS via 
Interplay” on page 104.

 Check out the sequence file from Interplay Access 
and drag and drop it to Avid DS.

“Importing and Opening the Sequence in Avid DS” 
on page 104.

 On your Avid DS system, finish the production. Refer to the appropriate sections in the Avid DS 
Help.

Step Refer to



4  Conforming Projects on Avid DS in an Interplay Environment

88

Workgroup with Shared Storage in an Avid 
Interplay Environment

If you will be collaborating with other editing workstations in an Interplay environment and 
sharing media storage on an Avid Unity storage, then the illustration below shows how the 
individual workspaces need to be indexed so that media can be accessed quickly.

You should also read the section on “Sharing Media” on page 91 as it provides important 
recommendations on accessing and indexing your media in a workgroup.

 Export or output the sequence to an Avid editing 
application by using the Timeline to MC feature.

“Using Timeline to MC to Output a Sequence to 
Avid Media Composer” in the Help for Avid DS.

Step Refer to

AVID DS CONTROLLER

CLIENT 1
Avid DS workstation

CLIENT 2
Avid DS workstation

AVID UNITY

DS CLIENT 1
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DS CLIENT 2
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 Symphony
workstation

Media Composer
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Symphony
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Media
Composer
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AVID INTERPLAY SERVER

Avid DS Media Indexer 
indexes DS workspaces

Interplay Media Indexer 
indexes workspaces for 

Avid editing systems

AVID DS RP STATION
Processes jobs for DS workgroup
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Avid Unity

• The Avid Unity storage needs to have a workspace for each Avid DS client. Within the 
workspace, set up separate folders for video and audio, and set the necessary 
permissions.

- Unity video storage - \\UnityServer_name\workspace_name\video

- Unity audio storage - \\UnityServer_name\workspace_name\audio

An RP workstation does not need a workspace since it processes directly to the Avid DS 
client workspace. However, the RP workstation does need permission to access the 
Unity workspaces for each Avid DS workstation (for remote processing requests). 

The controller will also need permission to access the Unity workspaces for each client.

• Create workspaces where other Avid editing systems (Media Composer, Symphony) can 
place media that will be shared with Avid DS (audio and video can be stored in the same 
folder). 

- Unity storage - \\UnityServer_name\workspace_name\MXF

Avid Interplay Media Indexer

The Interplay Media Indexer is installed on a dedicated server within the Interplay 
environment. It only needs to index media for non-DS workstations. (The Avid DS 
controller will index media for the Avid DS workgroup).

• Configure a media indexing service that contains the workspaces belonging to other 
Avid editing systems (Media Composer, Symphony).

Avid DS Controller

• Set up a dedicated workstation to index the media for the Avid DS workgroup.

• The project indexer should also be installed here. Set the project root folder on this 
workstation and set the permissions on this folder for access by all DS client 
workstations.

• Configure the media indexing service on the Controller to include the Avid DS 
workspaces on the Unity storage—see “Configuring your Storage Locations” in the 
Help for Avid DS.

Avid DS Client Workstations

For each Avid DS workstation in the workgroup:

• When adding a project, make sure you create it on the controller (in the project root 
folder).

• Configure a media indexing service for the workstation:
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Configuring the Interplay Adapter

You must configure the Interplay Adapter to establish a connection between each Avid DS 
workstation and the Interplay database. You will only need to do this once. 

To configure the Interplay Adapter:

1. In Avid DS, select File > User Preferences.

2. In the User Preferences dialog box, click the Interplay Access property page.

3. In the Interplay Connection box, enter the following:

t The name of the server where the Interplay database is located.

t The name of the Interplay database you are connecting to.

t The username and password.

You must have permission to log onto the Interplay database. Usernames, passwords, 
and permissions are issued by the system administrator.

4. Click Connect.

In the Current Check In Directory box, all projects on the database that you have 
permissions to access are listed.

Do the following Refer to

Add the client’s audio/video workspaces on Avid 
Unity.

“Configuring your Storage Locations” in the 
Help for Avid DS.

If the workstation also has media on 
locally-connected storage, then add this storage to 
the media indexing service.

Add the controller’s media indexing service to the 
Avid DS client’s media indexing service. This will 
automatically give the Avid DS workstation 
access to all the other DS client workspaces on 
Unity (if the necessary permissions have been 
granted).

“Accessing Storage on another Workstation” 
in the Help for Avid DS.

Add the Interplay media indexing service to the 
Avid DS client’s media indexing service. This will 
automatically give the Avid DS workstation 
access to all other Avid workspaces on Unity (if 
the necessary permissions have been granted).

“Stopping and Starting your Avid Indexing 
Services” in the Help for Avid DS.
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5. Click OK.

Sharing Media

Sharing media saves you time and disk space as you only have to capture the media once. If 
other users in your workgroup want to use the media, they can simply import the sequence 
or master clip into their project. The clips will then link directly to the associated media.

In a workgroup environment, the location of your media and projects can make a big 
difference to your performance and processing times. For instance, if you are working in 
isolation on a project, then having the related media on your local storage gives you 
real-time playback of the sequences. 

On the other hand, if you are working on the same project with other Avid DS workstations 
that need access to the same media, then it would be more efficient to store the media in one 
location. You save on storage space as there is no redundancy of media on each workstation. 

n When sharing media on storage areas connected on a network, there may not be sufficient 
bandwidth to provide realtime playback of the media. If you are using an Avid Unity storage, 
it does have enough bandwidth to handle realtime playback.

If you are not getting realtime playback with the shared storage you are using, you can copy 
the media to a local storage connected to your workstation.
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Points to consider when sharing media:

• One workstation, preferably the controller, should hold all projects and take care of the 
indexing and processing services. The indexing service on the controller will be 
configured to index media on all connected storages in the workgroup (including 
workspaces on Unity).

• If your workstations are sharing Avid Unity storage, then each workstation using this 
storage must have a fibre-optic cable connection to the Avid Unity system for optimal 
performance.

• If many workstations are working on the same project and will be sharing the same 
media, then place all media on one storage device.

• If you are sharing media on an Avid Unity workspace, make sure that both the offline 
and the online systems have access to the workspace.

Points to consider when sharing projects:

• In a workgroup, a user can open a project from any Avid DS workstation in the 
workgroup.

• A project can only be opened by one user at a time.

• If you need to work on a sequence within a project that is already open by another user, 
you can import the sequence and link to media (so that you are still sharing the media). 
This sequence can later be imported back into the original project.

The Avid DS Indexing Services

The Avid Media Indexer and the Avid Project Indexer manage your projects and media more 
efficiently. These services actively monitor and index the storage areas that you’ve defined to 
allow for improved performance, better sharing of media across a network, and better 
interaction between Avid DS and an Avid DS RP (remote processing) workstation. 

The Media Indexer can manage media of different formats, such as video, audio, source, 
cache, .gen files (the native Avid DS format), .omf files (the native Symphony and Media 
Composer format), and .mxf files (industry-standard format that encapsulates media and 
production metadata into a single file). 

Each workstation has its own media indexer which indexes the audio and video storage areas 
on that workstation. The media indexing service on a workstation contains a list of storage 
areas that the workstation requires. These storages are accessed and indexed in the order in 
which they are listed.
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In a workgroup, the Project Indexer works with the media indexing service on each 
workstation and keeps an up-to-date index of the location of all media. So, for example, 
when the Purge command is executed from any workstation within the Avid DS workgroup, 
the correct media for the selected project is purged. 

Indexing Shared Storage on Avid Unity

On Avid Unity MediaNetwork and ISIS, the Avid Media Indexing Service does not retain its 
index table of the media if the workstation hosting this service is rebooted. This is a known 
limitation.

When the workstation is restarted, the Avid DS Media Indexing Service automatically scans 
and indexes all of the Avid DS-defined Unity storages. The indexing will take the time it 
needs to validate the many files and workspaces used for the Avid DS audio and video media 
files.

n The media remains online but the actual media verification occurs in the background to 
validate the media table. This allows the editor to work but it still prevents basic media 
management that depends on the Media Indexing Service, such as purging and archiving.

To avoid losing time while the media indexer rebuilds the index table, Avid strongly 
recommends that the Media Indexer be installed on a standalone workstation such as the 
Controller. 

Furthermore, if you have to shut down this workstation, make sure you first stop the 
indexing services manually to avoid corruption of the index table—see “Stopping and 
Starting your Avid Indexing Services” in the Help for Avid DS.

Actual path to storage area

Workstation Name
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Sharing MXF Media

MXF (Material Exchange Format) is an industry-standard container format that encapsulates 
media and production metadata into a single file. MXF is also a common file format for 
direct media interchange among Avid applications, as well as with third-party 
MXF-compliant products. MXF supports both standard-definition and high-definition 
formats. 

Avid DS can share HD projects and Avid DNxHD media with Media Composer HD-capable 
systems. When the MXF files are placed in a common location, Avid DS users can link to 
them in a conform workflow.

n  Avid Xpress Pro HD systems can also share this media, but cannot capture it. DNxHD 
media is compression format also used for MXF media so that you can deliver 
mastering-quality HD media at standard-definition data rates and file sizes. To share this 
media, you must be running Avid DS v7.5 QFE 3 or later, which is available from the 
Avid DS Support Center. 

For a list of shared DNxHD resolutions—see “Avid DNxHD Compressions” in the Help for 
Avid DS.

If you are reading or writing MXF media for use only by Avid DS: 

t Create the following audio and video MXF folders on your storage device using the 
Windows Explorer:

\\workstation_name\Avid MediaFiles\MXF\Video
\\workstation_name\Avid MediaFiles\MXF\Audio

If you are sharing media with other Avid editing systems on an Avid Unity:

t Create the following Unity workspace for MXF files that you are reading from other 
systems:

\\UnityServer_name\workspace_name\Avid MediaFiles\MXF

n These folders should only contain media that needs to be conformed and used by Avid DS, as 
there is no need to index all the offline media on an Avid editing system.

t Create the following Unity workspaces for MXF files that Avid DS is creating for use by 
other systems:

\\UnityServer_name\DS_workspace_name\Avid MediaFiles\MXF\Video
\\UnityServer_name\DS_workspace_name\Avid MediaFiles\MXF\Audio

Make sure to use the correct syntax:

- Include a space between Avid and MediaFiles
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- Don’t include a space for MediaFiles, Video, and Audio

- Use the correct uppercase and lowercase letters.

n Avid DS requires separate storage areas (one for audio and one for video) to write MXF 
media. Other Avid editing systems create a single folder for MXF media, named Avid 
MediaFiles\MXF, and can write both audio and video files to the same folder.

Sharing OMFI Media

Avid editing applications can export an OMFI file that contains all the editing information 
for the selected master clip or sequence along with the video and audio media files for that 
master clip or sequence. 

To create the OMFI folders:

t If you are linking to OMFI media within Avid DS, create the following video and audio 
folders on your storage device using the Windows Explorer:

- \\workstation_name\OMFI MediaFiles\VideoStorage

- \\workstation_name\OMFI MediaFiles\AudioStorage

t If you are linking to OMFI media on an Avid Unity, create the following folders:

\\UnityServer_name\workspace_name\OMFI MediaFiles\VideoStorage
\\UnityServer_name\workspace_name\OMFI MediaFiles\AudioStorage

Make sure to use the correct syntax:

- Include a space between OMFI and MediaFiles

- Don’t include a space for MediaFiles, VideoStorage, and AudioStorage

- Use the correct uppercase and lowercase letters.

Placing High-Resolution Media on the Storage Device

High-resolution digital footage that comes either from digital video cameras, film scanning 
processes or CGI applications (e.g. R3D, ARI, DPX, TIF), should be placed onto a fast, 
high-capacity storage device connected to your workstation. This allows you to link to these 
source files and still get real-time playback in Avid DS.

If this media is being shared with other Avid systems, you can place these master files on a 
shared storage, such as Avid Unity and link to it. 

n For a list of storages that support real-time playback, refer to the Avid DS Support Center. 
You can also place your media on a shared storage and link to it, but you may not get 
real-time playback unless you process the media.
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If you are working with different types of high-resolution media (e.g. R3D, ARI, DPX, TIF), 
make sure that they are each placed in different folders.

t For local storage. Place your high-resolution files in an appropriate folder under the 
\VideoStorage folder on the storage device. For example, 

\\workstation_name\VideoStorage\DPX\Casino\...

t For shared storage. Place the high-resolution files on a workspace on Avid Unity. For 
example,

\\UnityServer_name\workspace_name\Avid MediaFiles\DPX\Casino\...

Defining your Storage Areas within the Media 
Indexing Service

You must define all storage areas that you need to access inside a configuration called a 
media indexing service. The Avid DS media indexer scans all storages defined for each 
workstation and indexes the media for quick and efficient access. 

You cannot leave the Avid DS local media indexing service list empty, otherwise Avid DS 
will report missing audio and video storages every time you start the application. Configure 
both audio and video storages and name them clearly.

n If you are configuring the media indexing service on the controller,  The procedure describes 
how to include storage areas on other Avid DS workstations in the workgroup, so that 
workstations can access each other’s media.

To define your storage areas in the media indexing service:

1. In Avid DS, select Data Management > Configure Storages.

The Media Storage Configuration - Current Project dialog box displays the media 
indexing services that were automatically configured for your workstation when 
Avid DS was installed. 
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2. Select your workstation’s media indexing service, and click the Change button.

The Media Indexing Service dialog box displays.

3. Leave the workstation name as it is and click the Change button.

The list of storage areas that have already been defined in this indexing service displays. 
Each storage area is uniquely identified by the workstation name and folder where the 
media resides.

Your workstation’s 
media indexing 
service is 
indicated by the 
computer name
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4. To add a new storage, click the Add button.

5. In the Available Storage Types dialog box, select Avid Media Storage and click OK.

6. Enter the full Windows path name (\\workstation_name\folder_name) where the storage 
area is located, or use the browse (...) button to find it. For example, 
\\DSStorage4\Video. 

If you are connecting to a folder on an Avid Unity, then click the browse (...) button and 
locate the Avid Unity workspace folder. For example, 
\\UnityServer_name\workspace\folder_name. 
Do NOT use a drive letter.

Actual path to storage

Avid DS shared 
storage name
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7. If this storage is for sharing MXF media with another Avid editing system such as 
Media Composer, then select Prevent purge of media on this storage. This makes the 
storage “read-only”.

8. Select the media type that you will store in this folder:

n If there are different media types in your storage, you must add a storage configuration for 
each different type (e.g. generic audio, generic video, MXF audio, MXF video, etc.)

For this storage folder Select this option(s)

Video media imported or generated media by 
Avid DS (read/write).

generic video (.gen)

Audio media imported or generated media by 
Avid DS (read/write).

generic audio (.wav) 

Media that is going to be read-only, but not 
overwritten. e.g. OMFI media that will be used by 
other Avid editing systems.

None

For MXF media: Folders that contain MXF media must be defined separately within your 
media indexing service.

n You need to set up separate MXF folders for Avid DS and any other Avid editing 
systems— see “Sharing MXF Media” in the Avid DS Help.
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9. From the Disk Controller Type list, select the card that is installed in your workstation.

10. From the Disk Storage Type list, select the storage type that you are using.

The disk options set the appropriate bandwidth for Avid DS to use when transferring 
data to the storage. Choose the appropriate options for your storage device to obtain the 
best performance for real-time effects.

n If your storage device does not appear in the list, it may be because it was installed after 
Avid DS was installed. To make sure that it appears in the list, restart Avid DS so that the 
software detects the device.

11. Click OK.

The storage area is added to the Media Storage Configuration list.

12. Continue to add storage areas for all folders to which you need access. 

MXF audio (purgeable) — Read Only MXF audio files (.mxf)

MXF video (purgeable) — Read Only MXF video files (.mxf)

MXF audio (non-purgeable) • MXF audio files (.mxf)

• Prevent purge of media on this storage

MXF video (non-purgeable) • MXF video files (.mxf)

• Prevent purge of media on this storage

For this storage folder Select this option(s)

Storage areas will
be listed here as

they get added

Avid DS shared
storage name
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If there are different media types in your storage, you must add a storage configuration 
for each different type (e.g. generic audio, generic video, MXF audio, MXF video, etc.)

13. Storages are accessed and indexed in the order in which they are listed. Use the Move 
Up or Move Down buttons to change the order of priority.

14. Click Close and then OK to return to the Media Storage Configuration - Workstation 
dialog box.

15. Click Close and then OK to return to the Media Storage Configuration - Workstation 
dialog box.

16. Click the Close button to save the configuration for the media indexing service.

n By default, the media indexer sets any new storage areas to automatically have full 
read/write access by any user on the network. To restrict access to your media, you can 
change the share permissions through Windows—see “Sharing Folders and Setting 
Permissions” in the Avid DS Help.

The first time that you configure your storage, the media indexer will need to index the 
media on your storage device. This may take a while depending on the amount of media 
on your storage.

17. Once your storages have been indexed, you should stop and restart the media 
indexer—see “Stopping and Starting your Avid Indexing Services” in the Avid DS Help.

Avid DS shared
storage name
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Accessing Storage on Workstations in an Avid 
Interplay Environment

A media indexing service is defined for every workstation in an Interplay workgroup. The 
media indexing service includes all storage folders that the workstation needs to access. To 
access media created by other Avid editing systems within an Interplay environment, you 
need to connect to that system’s local Interplay media indexing service, or to the media 
indexing service for a group of Avid editing systems known as a High Availability Group 
(HAG).

To access an Interplay media indexing service:

1. Select Data Management > Configure Storages.

The Media Storage Configuration - Current Project dialog box is displayed with a list of 
existing services. 

2. To add a new service, click the Add button.

The Available Storage Types dialog box is displayed.

Your workstation’s 
media indexing 
service
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3. Select Avid Interplay Media Indexer and click OK.

A dialog opens for you to enter information about the Interplay media indexer to which 
you need to connect.

4. Enter the name of the Avid Interplay workgroup where the media is located.

5. Enter the name of the Avid editing system whose local indexing service you need to 
access,

or

the name of the HAG where the shared indexing service is located, and select the This is 
the name of a High Availability Group (HAG) option. 
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6. Set the Disk Controller Type and Disk Storage Type.

7. Click Close to accept this configuration.

The Interplay media indexing service is now added to your storage configuration.

8. Click the Close button to exit the Media Storage Configuration - Current Project dialog 
box.

To remove a media indexing service:

1. In the Media Storage Configuration - Current Project dialog box, select the service that 
you want to delete.

2. Click the Remove button.

The indexing service is no longer defined for the current project.

3. Click the Close button.

Exporting the Finished Sequence to Avid DS via 
Interplay

Avid DS cannot directly open projects from the Avid editing system. Therefore, you must 
export the finished sequence in an intermediate file format using the Avid Interplay Window 
in the Avid editing system. 

The Interplay Window is a built-in lighter version of Avid Interplay Access that allows you 
to work with clips and sequences in a shared storage environment. 

For information on how to check file assets in and out of the Interplay database using the 
Interplay window, see the Avid Media Composer documentation.

Importing and Opening the Sequence in Avid DS

The offline sequence from the Avid editing system must be checked in, using Avid Interplay 
Access or the integrated Interplay window, to a location that can be accessed by Avid DS. 

To import the offline sequence:

1. On the Avid DS workstation, launch Avid Interplay Access.

2. Navigate to the location of the sequence.

3. Drag and drop the sequence to the Avid DS Explorer.

4. In the DS Explorer, double-click the AAF to open the bin.



Importing and Opening the Sequence in Avid DS

105

5. Double-click the bin to display its contents.

The contents will include master clips, subclips, and sequences.

For a description of Avid editing system icons—see “AAF/AFE List” in the Help for 
Avid DS.

6. Drag the sequence to the first track of the timeline.

Master clips

Sequence
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Avid DS creates master clips in your project folder, and the sequence automatically 
links to the media on your storage device. All cuts, edits, and effects applied in the Avid 
editing system are visible on the timeline.

7. You can now finish the sequence in Avid DS. 
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